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This document provides a step by step by guide on use of
the Bulk EFT/ACH Input Template (Microsoft Excel). This
client tool is targeted to business clients/users utilizing
bulk EFT/ACH services: RBC Automated Direct Credits
and Electronic Payroll and RBC Automated Direct Debits.
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SUMMARY TABLE OF STEPS TO USE THE TEMPLATE

STEPS DETAILS / PARTICULARS

Using the Template for the First Time

1. Save the original RBC Bulk
ACH Input Template (Excel)

Save the original template to your computer or desired location (available via
www.rbc.com/caribbean or sent via email from RBC bank official)

2. Open the template/tool and
save as a new document

Open the template and save as a new document with a different name (e.g. Bulk ACH
Input-April KYD Salaries). In this way, you will readily have access to an original version
of the template, in the event that you need to capture different Originator Information.
e.g. use another settlement account etc. in the future.

N.B. Once captured in a file and saved, Originator Information cannot be updated.
Should you need to change Originator Information, access the original template,
capture the information and save as a different file name.

Please note that different files are required for KYD versus USD items, and debit versus
credit items, that is, KYD and USD items or debit and credit items cannot be mixed in
one file.

3. Input Originator Information

Branch, Originator Name, Originator ID, Account number, Effective Date, Debit/Credit,
Transaction Class, Account Type, Currency

Closely review the Originator information before saving, as this cannot be updated in
this file. A new file would have to be opened to facilitate this.

4. Input Recipient Information
(for first recipient on sheet)

Institution, Recipient Name, Recipient ID, Account Type, Account Number, Amount,
Addenda (optional)

5. Add Recipients in iterative
process

Click “Add” transaction tab, at the bottom right corner of the user interface screen

6. Save/Close

Click on the “Save/Close” tab on the bottom left corner of the interface screen to save
data during capturing process

7. Review Data

Click on “View” tab to review data captured to spreadsheet. The View tab allows you
to change focus to the Spreadsheet in the background; from there you can select
RETURN TO USER INTERFACE on the Spreadsheet to return focus to the User
Interface

Click on “Update” tab to make changes to Recipient information (Using UP/DOWN
ARROW) (Note: Originator information cannot be updated)

8. Save File as CSV

The user is required to click on the “Save file as CSV” button on the bottom left section
of the interface screen.

Reminder different CSV files are required for the following:
KYD credit items; USD credit items; KYD debit items; USD debit items.

9. Submit Bulk EFT/ACH File

Email CSV file as an attachment, using RBC approved secured mail mechanisms to
Generic Email Box to;: caymanap@rbc.com

Reusing the Template/ Updating Effective Date

1. Open the template/tool
provided

From saved location on your computer

2. Update Effective Date

Click ‘Update Effective date’ button in the Excel sheet to change effective date and
create new file

3. Make necessary changes to
any applicable recipient data.

Once a new date is selected, you will notably be allowed to make necessary changes to
recipient data to prepare a new CSV file. Return to the User Interface and click on the
“Update” tab

4. Save

Click Save

5. Save File as CSV

The user is required to click on the “Save file as CSV” button on the bottom left section
of the interface screen

6. Submit Bulk EFT/ACH File

Email CSV file as an attachment, using RBC approved secured mail mechanisms to
Generic Email Box to: caymanap@rbc.com
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DETAILED STEPS USING TEMPLATE FOR THE FIRST TIME

Step 1- Save the Original RBC Bulk EFT/ACH Input Tool (Excel template)

» To your computer or desired location (available via www.rbc.com or sent via email from bank official).
Templates can be used to input: Payroll/Salary data 2. ACH Direct Credit data (any other misc. credits to
any payee e.g. vendors) and 3. ACH Direct Debit data.

Step 2- Open the template and save as a new document

» Open the template and save as a hew document with a different name (e.g. Bulk EFT/ACH Input-April
KYD Salaries).

o In this way, you will readily have access to an original version of the template, in the event that
you need to capture different Originator Information. e.g. use another settlement account etc. in
the future.

o N.B. Once captured in a file and saved, Originator Information cannot be updated. Should you
need to change Originator Information, access the original template, capture the information and
save as a different file name.

o Please note that different files are required for KYD versus USD items, and debit versus credit
items, that is, KYD and USD items or debit and credit items cannot be mixed in one file.

You will see the below empty spreadsheet, as below

» Next click on enable content
» Click on Return to User Interface (in order to input data)
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You will see the below interface:

Cayman lslands -

Cheguing bl

Section A- ORIGINATOR INFORMATION FIELDS/ RULES FOR DATA FIELDS

Step 3 Complete Mandatory Originator Information Section (A)
(Business Client sending a file is the Originator)

>

>

ISLAND — Cayman Islands (automatically populated) - no need to input data.

BRANCH - Select your RBC Branch, where your business account is held. If you are unsure of your
branch/transit, please see your business deposit statement — on the right of the address (in bold) one of
the following — 5 digit branch codes

Main Branch: 06975

Red Bay: 07925

Private Banking: 96677

Private Banking: 07136

Caribbean Plaza: 94945 (where account was previously held at this branch)

O O O O O
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5 Chequing_RIBS_ Upd PDF - Adobe Reader o G e e =y et DS - T ————| .| =] (-
File Edit View Window Help

x
BEe=| Nu|l=e==-|HEB |2 2| Fill & Sign Commenl‘

RBC ROYAL BANK (CAYMAN)
LIMITED

PO BOX 245 GRAND CAYMAN
CAYMAN ISLANDS BWI

7 digit “Account no.” here ACCOUNT STATEMENT
Complete 12 digit account no= RBC DAY TO DAY BUSIN
5 digit “Branch Transit” and 7 ESS
ggggggggl digit “Account no.” e.g. 5 digit “Branch ——
ADDNRAS 8 069751234567 Transit” here A‘?Eﬁf“fgfﬁf?°“
ADDRESS 4

POSTAL CODE

PERSONAL FINANCIAL SERVICES

Account No Statement Period Enclosed ltems Page
123-456-7 CAYMAN ISL DOLLAR 06 JUL 17 to 19 JUL 17 1

BALANCE BROUGHT FORWARD 653,877.34

ORIGINATOR NAME - Input your business name here, as per your deposit account name.
o Maximum field length = 22 characters
o Allowable characters alpha-numeric and spaces only (numbers 0-9, upper and lower case A-Z,
spaces)

ORIGINATOR ID- Insert the unique 6-7 digit Client Master Number for your company provided by the
Bank.

ACCOUNT NUMBER- Input your applicable KYD or USD 12 digit (numeric only) RBC business deposit
account number.
o Must add 5 digit branch transit before the standard 7 digit account number
o If you are sending a KYD file, you must input your KYD account number and if sending a USD
file, you must input your USD account number.
o Cross currency instructions will not be accepted.

EFFECTIVE DATE- Select the settlement date for the items from the calendar.
o If you choose to manual input a date this must be in yyyy/mm/dd format.
o Default value will be current date.
o Clients may input files with advanced effective dates up to a maximum of 3 business days in
advance.

DEBIT/CREDIT-

o Credit — Template Default. To use for payroll or other payment files such as vendor credits (this
will be mapped to an ACH Direct Credit File “DC” on the CSV file)

o Debit — Click on drop down menu and select “Debit” option if this is a collections file for
Automated Direct Debit (this will be mapped to an ACH Direct Debit File “DD” on the CSV file).

o Kindly note that a formal pre-authorized agreement (the Bank provides a template) must be in
place between your company (the Originator) and the debit Receiver (the person/company you
are collecting funds from) before debit files are submitted to the Bank, which must be validated by
the Receiver’s bankers. Your company is responsible for managing and storing these
agreements, which the Bank reserves the right to audit or request copies.

o Separate files are required for debit and credit items.
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» TRANSACTION CLASS-

Credit items

o When “Credit” is selected from Debit/Credit field, the Transaction Class will default to

“DirecPay”.

o Should you wish to use another available transaction class, click on the drop down menu and

select one of the following other transaction class options such as “Salaries”:

Transaction Transaction Class Codes
Class mapping for CSV file.
Bill Pay BP
DirecPay DD
Dividend DP
Insurance 1P
Pension PN
Salaries SA
Suppliers SP
Utilities uT
Debit items

o When “Debit” is selected from Debit/Credit field, the Transaction Class will default to “Auto

Coll”.

o Should you wish to use another available transaction class, click on the drop down menu and

select one of the following other transaction class options such as “Insurance”:

ACCOUNT TYPE. Default value will be displayed as “Chequing” for your company’s RBC Day to Day

o If you are sending a KYD file, you must input your KYD account number and if sending a USD

Transaction | Transaction Class Codes mapping
Class for CSV file
Auto Coll AC
Bill Pay BP
Insurance 1P
Sal Ded SD
Utilities uT
>
Business Accounts or RBC Business Essentials fixed fee plans.
o Chequing (This will be mapped to “C” on the CSV file)
o Savings (This will be mapped to “S” on the CSV file)
» CURRENCY- Select one of the two options either USD or KYD:
o Separate files are required for USD and KYD items.
file, you must input your USD account number.
o Cross currency instructions will not be accepted.
>

TOTAL AMOUNT- This field value will be automatically calculated and displayed- no action required.

o Calculation is based on the total dollar value of all recipient amounts within the file. This field
cannot be edited manually.
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Step 4- Complete Mandatory Recipient Information Section (B):
For each payee complete the following, this can include payees with accounts at RBC and all other participant

banks:

>

INSTITUTION — Select applicable Receiver “Institution” from dropdown of all 5 Participant Banks in the
ACH (RBC, BNS, CNB, FCIB, Fidelity and Butterfield).
o You will be required to select the applicable branches for RBC and FCIB where the recipient
account is domiciled.

RECIPIENT NAME - Input the Receiver’s full name (as it appears on their account)
o Maximum field length = 22 characters
o Allowable characters alpha-numeric and spaces only (numbers 0-9, upper and lower case A-Z,
spaces)

RECIPIENT ID — Input applicable Receiver’s identification, such as their employee number with your
company or National Identification Number etc.
o Maximum field length = 15 characters
o Allowable characters alpha-numeric and spaces only (numbers 0-9, upper and lower case A-Z,
spaces)
o Where no information is available for a receiver which is an individual, input: no details
o Where not applicable where the receiver is an entity, input: not applicable.

ACCOUNT TYPE- This is the Receiver’s account type. Default value will be displayed as “Savings”.

o You can change the selection by clicking on the drop down menu and select “Chequing” as
required. Generally the most common account type where a receiver is an individual is a savings
account and where the receiver is a business is a chequing account.

o Chequing (This will be mapped to “C” on the CSV file)

Savings (This will be mapped to “S” on the CSV file)
o Tip —where recipient’s account is held at Fidelity, Savings account starts with a 2 and Chequing

account starts with a 1

@)

» ACCOUNT NUMBER- Input the Receiver’'s complete deposit account number.

o Numeric only- maximum 17 digits. No spaces/dashes should be included in account numbers e.g.
12345678900.

o See below participant bank account number length guide

o Please take steps to ensure that receiver’s account numbers are complete and accurate.
You may wish to have your receivers validate their account numbers. Kindly note that
based on ACH rules, entries may be processed based on account number only, even if it
identifies a person different from the named Receiver. The Bank will not be liable in
instances where erroneous account information is provided and processed and the Bank
is unable to recover the funds from the erroneous receiver/ the Receiving Bank.

Bank Name Account Number Max Length
Scotiabank BNS - 17 digits
Royal Bank RBC- 12 digits (5 digit branch transit number+ 7 digit number)

Fidelity — 8 digits
e Saving account start with a 2

Fidelity e Chequing account witha 1
Cayman National CNB- 8 digits
CIBC FirstCaribbean FCIB- 12 digits

Butterfield Bank clients have 11 digits

Butterfield- Maximum of 13 digit account numbers. A small percentage of
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e Accounts beginning 840 do not require leading zeros.

e Accounts beginning with 1 (except for 136) or 2 require a leading
zeros

» AMOUNT - Input amount to credit or debit Receiver account.
o Number format with two decimal places only e.g. 10000.00. No dollar sign.
o Must not exceed USD 500000.00 or KYD 416630.00.

» ADDENDA- Optional Field. Maximum 80 characters.
o Can be used for comments, particulars or additional information, such as a biller reference
number, invoice number, policy number etc.

Transaction Count-_No action required. Transactions count will be automatically displayed based on the
number of transactions captured on this file.

Step 5- Add Transactions

» ADD - To continue the iterative process to add more recipients to a file, click on the “Add” Button at in
the transaction section at the bottom right section of the interface screen.
o Automatic error prompts will be displayed if there are identified errors or missing items for any of
the mandatory fields, before committing the transaction to the Spreadsheet.
o N.B. Once the first transaction is added Originator information cannot be modified.

Step 6- Save Transactions/Files
» SAVE / CLOSE — Users should save items during this process, by clicking on the “Save/Close” button
on the bottom left section of the interface screen
o Saves the data entered onto the Spreadsheet at any point in time and closes the Excel / User
Interface.

» SAVE FILE AS CSV - The user is required to click on the “Save file as CSV” button on the bottom left
section of the interface screen.
o Saves data entered on the Spread sheet in required CSV file format.
o The user can select the location (file folder) where the CSV file should be created.
o This button becomes available and can be selected when there is at least one (1) transaction on
the Spreadsheet.

Step 7- Review Data
» Click on “View” tab to review data captured to spreadsheet. The View tab allows you to change focus to
the Spreadsheet in the background; from there you can select RETURN TO USER INTERFACE on the
Spreadsheet to return focus to the User Interface.
o Click on “Update” tab to make changes to Recipient information (Using UP/DOWN ARROW)
(Note: Originator information cannot be updated).

Step 8- Save as CSV File

» Save the completed template as a CSV file in the designated folder
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Step 9- Submit Bulk EFT/ACH Files via Secure Email

» Proceed to email the spreadsheet using RBC approved secured mail mechanisms to Generic Email Box:
caymanap@rbc.com

TAB GUIDE (Bottom of Interface Screen- Section C)
Spreadsheet Section:

VIEW- Provides the user the ability to change focus to the Spreadsheet in the background; from there the user
can select RETURN TO USER INTERFACE on the Spreadsheet to return focus to the User Interface.

CLEAR - Deletes all transactions committed to the Spreadsheet. It is meant to be used after the Spreadsheet is
saved using “Save as a CSV file” and is required to be cleared to start afresh. This button becomes available and
can be selected when there is at least one (1) transaction on the Spreadsheet.

SAVE / CLOSE - Saves the data entered onto the Spreadsheet at any point in time and closes the Excel / User
Interface.

SAVE FILE AS CSV - Saves the data entered on the Spread sheet in CSV file format. The user can select the
location (file folder) where the CSV file should be created. This button becomes available and can be selected
when there is at least one (1) transaction on the Spreadsheet.

Transactions Sections:

ADD - Validates each field entered (except Addenda) before committing the transaction to the Spreadsheet;
appropriate Error Messages are displayed to ensure the correct data type is entered. Note — all fields with the
exception of Addenda are mandatory. Once the first transaction is added Originator information cannot be
modified.

CLEAR - Clears data from all the input fields of the Recipient Information Section on User Interface.

DELETE- Deletes the transactions of selected (Using UP/DOWN ARROW) Recipient from the spreadsheet. The
user will be prompted to confirm deletion of the transaction displayed on the User Interface before the transaction
is deleted from the Spreadsheet. This button can be selected on clicking UP/DOWN Arrow key i.e. after adding at
least a single record to the spreadsheet (Note: Originator information cannot be deleted).

UPDATE- Allows changes to be made to any field of Recipient information selected (Using UP/DOWN ARROW)
transaction. This button can be selected on clicking UP/DOWN Arrow key i.e. after adding at least a single record
to the spreadsheet (Note: Originator information cannot be updated).

UP / DOWN ARROW — Moves and displays all records sequentially.

e UP Arrow moves backwards.

e DOWN Arrow moves forwards starting with the first row of the Spreadsheet and ending with the last row
of the Spreadsheet.

e The option to UPDATE or DELETE a transaction is available as it is displayed onto the User Interface.
UP/DOWN Arrow will be enabled after adding at least one (1) transaction. On Clicking UP/DOWN Arrow
UPDATE and DELETE buttons will be enabled.
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SPREADSHEET

Sheet1 is the user’s main worksheet.

CapmansHipurChentyL - Msesoh Escel

Update Effective Date

=
=
=

« 4+ | sheet1 Sheets “Shess F3
sy | 2

e Transactions entered via the User Interface can be reviewed here.
e Transaction amendments (updates/deletions) should be done using the User Interface, as this is the point
of data validation.

DETAILED STEPS FOR REUSING TEMPLATE

Step 1- Update effective date option

To reuse a previously created/existing excel template, to create new CSV file with a new effective date (e.g. to
pay monthly salary on the next month):

» Click ‘Update Effective date’ button in the Excel sheet to change effective date and create new file.
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» When ‘Update Effective Date’ button clicked, you will have option to select a new effective date to update
effective date.

Step 2- Make necessary changes to recipient data

» Once a new date is selected, you will notably be allowed to make necessary changes to recipient
data to prepare a new CSV file.
» Click Save, as seen in the below screen shot.

.
RBC Cayman ACH User Interface_Update_EffectiveDate [

2018/03/12 i
2018/03/21 <

Step 3- Save as CSV File

» Save the completed template as a CSV file in the designated folder

Step 4- Submit Bulk EFT/ACH Files via Secure Email

» Proceed to email the spreadsheet using RBC approved secured mail mechanisms to Generic Email Box
caymanap@rbc.com

END-OF-DOCUMENT
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